
Whiteboard: 1/60, f5.6, iso 1000, WB Use Grey Card, Manual Audio at level 11, focal length ½ way to ∞.  
H4n INPUT @ 95% gain. 

BBB 1/60, f5.6, iso 320, WB Use Grey Card, Manual Audio at level 11, focal length ½ way to ∞.  H4n 
INPUT @ 95% gain. 

BBB Check  Horizontal Level & Billy’s Lights!!  ​ Middle line at bottom 1/3 of desk & remember 
Billy and Bo chair locations! 

Title: Harnessing the Power of Spreadsheets in Physics – zoom at 250% 
Mr.p: Good morning. In my opinion, physics students 

have to know how to use a spreadsheet program to 
analyze lab data. That’s why I call it, “Harnessing 
the Power! Of the spreadsheet.” [intro] 

Billy: Yeah!​ Bobby: Okay.​ Bo: That’s kind of 
weird. 

Mr.p: I am going to demonstrate by using the 2016 
version of Excel. However, there are all sorts of 
other spreadsheet programs like Numbers, Sheets, 
NeoOffice. They all have similar functionalities, so 
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this demo should be useful no matter what program 
you use. Let’s start with a basic experiment. Let’s 
say we have a cart on an incline. The initial velocity 
of the cart is zero, we are adjusting the 
displacement of the cart, and measuring the time it 
takes to traverse the displacement. We will 
eventually graph displacement as a function of 
change in time. Let’s start by inputting the 
information into our spreadsheet. These rectangular 
boxes are called “cells” and each cell is labeled with 
a letter in the x-direction and a number in the 
y-direction. In other words the first cell is A1. In A1 
let’s put “Change in Time (s)”. “Change in Time” 
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labels the data in this column as the change in time 
and the parenthetical “s” tells us the units for the 
change in time are seconds. And we can input all of 
the data we collected for the change in time. [input 
data] That data looks strange aligned to the right of 
the cell, so I can click in the upper left corner to 
select all the cells in the worksheet and then click 
on this icon to center all the text in the worksheet. 
… Be careful to notice the tabs at the top because 
they change the menu of icons. The text alignment 
buttons are under the “home” tab. {hear Bobby} Yes 
Bobby? 

Bobby: (Mr. p?) … We could use “delta t” instead of 

0266 Script - Harnessing the Power of Spreadsheets in Physics.docx​ Page 3 of 29 
 
 



“change in time”, correct? 
Mr.p: Sure, we could use delta t. Delta is a Greek 

symbol, so we would need to go to Insert → Symbol 
and then search for the Greek letter “delta”. You 
could write either change in time or delta t, they 
mean the same thing. … Next lets add a column 
with our displacements in centimeters. 
{displacement (cm)} Our first displacement was 10 
centimeters and each trial after that increased the 
displacement by 10 centimeters. So, there is an 
easy way to input that data and it requires we use 
an equation via the equal sign. In cell B3, which is 
directly below B2, we type an equal sign and then 
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click on cell B2. Notice how this adds B2 to our 
equation. Then we can type plus 10 to add 10 
centimeters to the original 10 centimeters in B2. 

Bo: That seems kind of dumb. We could’ve just typed 
in 20, instead of equals B2 plus 10. Typing 20 
would’ve taken less time. 

Mr.p: Sure. However, we can now select cell B3 and 
bring the pointer or cursor to the lower right corner 
of the cell. Notice how the cursor icon changes 
which indicates we can now click and drag all the 
way down to “drag and fill” the repeated equation. 
Clearly, this takes less time than typing in all the 
data, right? 
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Bo: I guess so. 
Mr.p: “Drag and fill” copies and pastes the equation 

and it uses a relative reference which means the 
equation always uses the cell directly above the cell 
with the equation in it. {illustrate} There is a lot we 
can calculate from here. Let’s start with the average 
velocity in centimeters per second. {average velocity 
(cm/s)} Billy, how do you think we could calculate 
that? 

Billy: Well, I bet we could use the equal sign to do an 
equation. The equation for average velocity is 
displacement over change in time. So in cell C2 
type equals cell B2 and then divided by, which is 
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the forward slash, and then cell A2. 
Mr.p: That is correct Billy. Notice you can either type 

in the cell name “A2” or you can click on the cell 
using the cursor. And again, we can select the cell 
we want to use to “drag and fill”, bring the cursor to 
the lower right corner, and click and drag down to 
“drag and fill” the equation. 

Bo: Rather than typing “Average Velocity” for the 
heading of this column of data, could we use v with 
a subscript of “avg” for velocity average? 

Mr.p: Sure. The way you would do that is by typing v 
and then “avg” without a space. Then we need to 
change the format of just the “avg” text to 
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“subscript”. So we select just “avg” and then go to 
Format → Cells. Then we select the radio button 
next to “subscript”. That changes the format of 
“avg” to subscript. {hear Billy} Yes Billy? 

Billy: (Mr.p?) Why did we need to put the parenthetical 
“s” in the column heading, couldn’t we have just put 
“s” next to all of our numbers? 

Mr.p: Ah, yes. Notice what happens when we do that. 
Adding the “s” makes it so the equations no longer 
work because the spreadsheet program assumes 
what is in the cell is text and not a number, and it 
won’t perform calculations on text. That is why we 
put the units at the top of each column instead of in 
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the cell with the data. … Does anybody see 
something currently wrong with our data? 

●​ Bo: Nope. 
●​ Bobby: … Significant figures. There is no way we 

know the average velocity to … what is that? … 10 
sig figs? 

Mr.p: Correct. We need to change the number of sig 
figs we are displaying. Start by selecting the data 
you want to change the display of and then click on 
these two buttons to increase or decrease the 
number of digits displayed. I would argue we know 
the displacement to the nearest millimeter, so we 
can display to the tenth of the centimeter. We can 
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do the same thing with the average velocity. I would 
argue that three sig figs seems to be a reasonable 
number to display. {hear Bobby} Yes Bobby? 

Bobby: (Mr. P?) Why do you keep saying “display”? It 
looks to me like we are changing the number, not 
just the “display” of the number. 

Mr.p: Ah, right. It is important to realize we are not 
changing the number itself, but rather just changing 
the number displayed. The spreadsheet does not 
round the number to what is displayed; it just 
changes what you see. … Okay, now let’s make a 
graph or chart. Click on the “Insert” tab because we 
are going to insert a chart. To the right of where it 
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says “recommended charts” there are chart type 
options. Typically in physics we use an “ X Y 
scatter” chart, so we click on that and typically we 
use a scatter chart that does not have lines between 
the data points, so let’s choose that one. At this 
point the program tried to figure out what data we 
wanted, however, it did not guess correctly. We will 
deal with the data in a moment, however, let’s first 
decide where we want the chart to be. We can drag 
it over to the right so it does not cover any of our 
data or we can move it to a different sheet. To move 
the chart, select the chart and then click on the 
“Chart Design” tab and then the Move Chart button. 
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Then we can move the chart to its own sheet rather 
than keeping it as an object in our original sheet. 
Notice we now have a sheet with the data and a 
sheet with the chart. If you have a lot of data or 
want to print the chart large and on its own page, 
this may be the way to go, however, because we 
don’t have that much data for this experiment, I am 
going to move the chart back to being an object in 
our original sheet. … Okay, now we need to select 
our source data for the chart. With the chart 
selected, again select the “Chart Design” tab, and 
click the “select data” button. You can see the 
program decided to add two data series 
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“displacement” and “velocity average”. I find the 
easiest thing to do here is to remove all the data so 
we can start new. So click the “minus” button twice 
to remove the two data series. Now chose “add” to 
add a data series to the chart. If you have multiple 
data series, it can be helpful to give the series a 
name, however, because we will only have one data 
series for this chart, I am not going to name it. Now, 
we need to decide what goes on our y and x axes. 
We are going to graph displacement as a function of 
change in time. Can anyone tell me what we need to 
put on the y and x axes? 

●​ Bobby: … I think it is always y as a function of x, 
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right? 
●​ Billy: Yea. It’s always y as a function of x, so if we 

are graphing displacement as a function of change 
in time… 

●​ Bo: Then displacement goes on the y-axis and 
change in time goes on the x-axis. 

Mr.p: Right. So, for the x values, click on the button to 
the right of where it says “x values” and this 
collapses the dialogue box so you can more easily 
access the data. Click and drag to select the 
change in time data. Note you need to select the 
data only, do not include the “change in time” 
header. In my experience, including the header 
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sometimes confuses the spreadsheet program. 
Again, just select the data. Once you have selected 
just the data, press return to open the “select data 
source” dialogue box again. And repeat the 
process for the y-axis values. Click the button to 
the right of Y Values, select just the displacement 
data for the y-axis, and click “return” to return back 
to the “select data source” dialogue box. And then 
click “OK” to finish selecting your data. And there is 
our data in chart form. 

●​ Bobby: … I feel like the graph is missing some 
things. 

●​ Bo: Yeah. 
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●​ Billy: And it looks like one of those data points is 
wrong. The data point at about 2.1 seconds does 
not seem to follow the general trend of the rest of 
the data. 

Mr.p: Sure. Let’s start with the errant data point. It 
looks like that data point is where the change in 
time is 2.088 seconds and the displacement is 120 
cm. … Oh, will you look at that? When I go back to 
my original, hand written data, it turns out I 
accidentally typed in that change in time 
incorrectly. The change in time is actually 2.880 
seconds and not 2.088 seconds. Oops, that’s my 
bad. Let me fix that. {fix} Oh, and will you look at 
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that? Fixing the change in time also fixes the 
average velocity for that data point and fixes the 
graph. It looks like, if you make an error and then 
fix it, the change propagates through the entire 
spreadsheet. How about that? 

●​ Bobby: I bet he did that on purpose. 
●​ Bo: I bet he’s going to say harnessing the power 

now. 
Mr.p: That is how you Harness the Power of a 

Spreadsheet! 
Billy: Yes! Harness the Power!!​ ​ Bobby and Bo: 

{react} 
Mr.p: Okay, now back to the fact that our chart is 
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missing some things. With the chart selected, we 
can click on the “Chart Design” tab and then “”Add 
Chart Element’ and there are several options. Let’s 
add “Primary Horizontal” and “Primary Vertical” 
axes titles. Rather than “Axis Title” we should add 
what variable is on each axis and include its units. 
For example, on the y-axis we have displacement 
in centimeters, on the x-axis we have change in 
time in seconds. … I don’t feel this chart needs a 
title, so let’s remove that. … I also don’t feel like the 
legend is adding anything, so let’s remove that as 
well. … Okay, now let’s add a best fit line or a best 
fit curve, in this program it is called a “trendline”. So 
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let’s add a “trendline”. I find the best way to do this 
is to select “more trendline options”; this presents 
you with more options to chose from. It defaults to 
a “linear” trendline. I would suggest selecting the 
radio button to “display equation on chart”. This 
displays the equation for the best-fit line or 
trendline. In addition, if applicable, you should 
select the radio button to “set y-intercept to zero”. 
Notice the original best-fit line equation is in the 
slope intercept form of a line, y equals m x plus b, 
or the y value equals slope times the x value plus 
the y-intercept. Selecting “set y-intercept equal to 
zero” forces b, or the y-intercept to equal zero. 
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Okay, now I am going to move the equation to 
make it easier to read. And clicking back on the 
trendline brings back the “format trendline” 
options. {hear Billy} Yes Billy? 

●​ Billy: (Mr.p?) That trendline does not approximate 
the data very well. 

●​ Bo: And the trendline does not go through the 
origin, even though you said we “set the y-intercept 
equal to zero.” 

Mr.p: Right, okay. Let’s deal with Bo’s observation 
first. Realize the trendline does not, by default, 
extrapolate beyond the data, it only interpolates 
between the data. In other words, the trendline 
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defaults to only displaying within the horizontal axis 
bounds of the known data. That is why the 
trendline does not extend to the left beyond our 
data all the way to the origin. … With regards to the 
trendline not approximating our data, that is 
because when the acceleration of the object is 
constant, the relationship between displacement 
and change in time is not linear, it is actually a 
polynomial of order two. Notice when we change 
our trendline option to “polynomial of order 2”, the 
trendline approximates our data extremely well. 

Billy: Wow, it really does. That cool!​ Bobby: Yep. ​
Bo: Sure. 

0266 Script - Harnessing the Power of Spreadsheets in Physics.docx​ Page 21 of 29 
 
 



Mr.p: Just a little bit more about the physics of this 
best-fit line or trendline. The spreadsheet program 
displays the trendline equation with dummy “y” and 
“x” variables because it does not know what is on 
our y and x axes. However, we know displacement 
is on the y-axis and change in time is on the x-axis, 
therefore this best-fit line equation is actually 
displacement equals 12.5 times change in time 
squared plus 5.25 times change in time. This 
equation represents the relationship between 
displacement and change in time for our particular 
experiment. 

●​ Billy: Oh boy, so we could use that equation to 
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determine the displacement of the cart for any 
change in time. All we have to do is plug the 
change in time into the equation and bam! We have 
the answer!! That is awesome! 

●​ Bobby: Wow.​ Bo: That is pretty cool. 
Mr.p: Yes, it is pretty cool, because it’s physics. And 

that equation is actually one of our uniformly 
accelerated motion equations; displacement equals 
velocity initial times change in time times one half 
acceleration times change in time squared. 

●​ Bobby: Uh, wait a second. I thought the initial 
velocity was zero in the experiment. That equation 
shows the initial velocity as 5.25 centimeters per 
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second. Why is that? 
Mr.p: Very nice Bobby. That discrepancy shows that 

there must be experimental error, which there 
always is. … Okay, if you think this is harnessing 
the power of a spreadsheet, imagine if you are 
doing something like this!!!! Ooh Ahh AHHH! 
{Numerical Modeling excel file} 

BBB: Ahh. ​ Eek.​ ​ Uh.​ What?​ Yes!​ Yipee. 
Mr.p: A few other items you may need to know. To 

multiply a number use the asterisks. {2*130 =}… To 
get an exponent, use the “caret” symbol. Just so 
you know that is spelled C A R E T not C A R R O T. 
Just so you know, I did not realize I was spelling 

0266 Script - Harnessing the Power of Spreadsheets in Physics.docx​ Page 24 of 29 
 
 



caret incorrently until I was looking it up for this 
video. {10 cubed = & square root of 10 = } … In 
order to get pi in a spreadsheet you need to type 
the four characters P I start parenthesis and end 
parenthesis. Those four characters in order are 
treated as the number pi. {2pi =} … Be careful to 
use parenthesis when necessary. For example, four 
divided by two times two is not the same as four 
divided by the quantity two times two. … And the 
last thing is printing. Notice what happens when we 
click on “file” and then “print”, this defaults to 
printing in portrait orientation and it does not print 
the gridlines that display in the spreadsheet. … So 
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let’s add lines to our data table by selecting the 
whole table and then adding borders by clicking on 
the “format” tab, selecting “cells”, selecting the 
“border” tab and then choosing to add borders to 
both the “outside” and “inside” of all of our cells. … 
Then let’s click on “file” and “page setup”, change 
the orientation to “landscape” and adjust the 
scaling to fit everything to 1 page wide by 1 page 
tall. … Now when I go to print, notice we can see 
the data table better and everything fits on one 
page, which is really helpful. Clearly you need to 
adjust the print scaling depending on the amount of 
data, however, this is something you should always 
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adjust before printing. … Okay, I am sorry, 
however, there is one more thing we need to 
discuss. I showed only one way to do everything 
we did in this video; however, there are often many 
ways to get to the various dialogue boxes. For 
example, if you right click or two finger tap on the 
middle of the chart, it brings up a contextual menu 
where you can choose “select data” to bring up the 
“select data source” dialogue box. … You can right 
click or two-finger tap on the trendline itself to bring 
up a contextual menu where you can chose “format 
trendline” to bring up the format trendline dialogue 
box. … You can right click or two-finger tap on a 
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cell to bring up a contextual menu where you can 
select “format cells” to bring up a “format cells” 
dialogue box. … I highly recommend you become 
familiar with the contextual menus that come up 
when you right click or two-finger tap on items. 
Contextual menus are menus of options that 
change depending the context of what is selected. 
Contextual menus can be very helpful. … Also 
notice the symbol to the right of “format cells” in 
the contextual menu. This shows you that the 
keyboard shortcut for “format cells” is command 1. 
If you have a cell selected and press both the 
command and 1 keys at the same time, the “format 
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cells” dialogue box pops up. Keyboard shortcuts 
for operations you perform repeatedly can really 
save time. … Okay. I am finally done. I am sorry 
this took so long, but I had a lot to say about 
Harnessing the Power of a Spreadsheet! … Thank 
you very much for learning with me today, I enjoyed 
learning with you. 
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